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Задание на контрольную работу 
Моделирование нечеткой системы средствами  

Fuzzy Logic Toolbox системы MatLab. 

 

Порядок выполнения работы 
1. Ознакомиться с основными определениями нечеткой логики. 
2. Ознакомиться с возможностями и принципом работы программ, входящих в 

пакет Fuzzy Logic Toolbox. 

3. Изучить принципы работы систем нечеткого вывода по этапам. 

4. Разработать заданную нечеткую модель, используя систему нечеткого вывода 

Мамдани, входные и выходные переменные описать с использованием 3 

функций принадлежности для каждой переменной.  

5. Варьируя видами функций принадлежности входных и выходных 

лингвистических переменных, способами дефаззификации, проследить 

изменения точных значений выходной переменной при фиксированных 

значениях входных переменных. 

6. Сделать отчет о проделанной работе. Отчет должен содержать пошаговое 

описание построения системы нечеткого вывода с соответствующими 

скриншотами, параметры системы (способ дефаззификации). 

7. Ответить на контрольные вопросы. 

8. Вариант брать по списку из журнала старосты группы. 

 

Моделирование нечеткой системы средствами инструментария 

нечеткой логики Fuzzy Logic Toolbox системы MatLab. 

 

Построение нечеткой аппроксимирующей системы.  

Командой (функцией) Fuzzy из режима командной строки запускается 

основная интерфейсная программа пакета Fuzzy Logic — редактор нечеткой 

системы выводе (Fuzzy Inference System Editor, FIS Editor, FIS-редактор).  

Главное меню редактора содержит позиции: 

File — работа с файлами моделей (их создание, сохранение, считывание н 

печать); 

Edit — операции редактирования (добавление н исключение входных п 

выходных переменных); 

View — переход к дополнительному инструментарию. 

Командой fuzzy запускаем FIS-редактор. По умолчанию, исходный алгоритм 

вывода — типа Mamdani (о чем говорит надпись в центральном белом Блоке) н 

здесь никаких изменений не требуется , ею в системе должно быть два входа, 

поэтому через пункт меню Edit /Add input добавляем в систему этот второй вход (в 

окне редактора появляется второй желтый блоке именем input). Делая далее 

однократный щелчок левой кнопкой мыши по блоку input 1. меняем в поле имени 

его имя на «сервис», завершая ввод нового имени нажатием клавиши Enter. 



Аналогичным образом устанавливаем имя «еда» блоку input2 и «чаевые» — 

выходному блоку (справа вверху) output 1. Присвоим сразу же имя всей системе, 

например, «tip» (по-английски это и есть чаевые), выполнив это через пункт меню 

File/Save to workspace as... (Сохранить в рабочем пространстве как...).  

Зададим теперь функции принадлежности переменных. Напомним еще раз, 

что программу-редактор функций принадлежности можно открыть тремя 

способами: 

� через пункт меню View/Edit membership functions..., 

� двойным щелчком левой кнопки мыши по иконке, отображающей 

соответствующую переменную, 

� нажатием клавиш Ctrl+2. 

Любым из приведенных способов перейдем к данной программе. Задание и 

редактирование функций принадлежности начнем с переменной «сервис». 

Сначала в поллх Range и Display Range установим диапазон изменения и 

отображения згой переменной — от 0 до 10 (баллов), подтверждал ввод нажатием 

клавиши Enter. Затем через пункт меню Edit/Add MF перейдем к диалоговому 

окну и зададим в нем функции принадлежности гауссова типа (gaussmf) с общим 

числом 3. Нажмем кнопку ОК и возвратимся в окно редактора функций 

принадлежности. Не изменяя размах и положение заданных функций, заменим 

только их имена на «плохой», «хороший» и «отличный» (как в предыдущем 

примере). 

Щелчком левой кнопки мыши по иконке «еда», войдем в окно 

редактирования функций принадлежности для этой переменной. Зададим сначала 

диапазон ее изменения от 0 до 10, а затем, поступая как ранее, зададим две 

функции принадлежности трапецеидальной формы с параметрами, 

соответственно, [0 0 1 3] и [7 9 10 10] и именами «подгоревшая» и 

«превосходная». 

Для выходной переменной «чаевые» укажем сначала диапазон изменения — 

от 0 до 30, потом зададим три функции принадлежности треугольной формы с 

именами «малые», «средние», «щедрые»  

Перейдем к конструированию правил. Для этого выберем пункт меню 

View/Edit rules... Заметим, что в первом и третьем правилах в качество «связки» в 

предпосылках правила необходимо использовать не «И» (and), в «ИЛИ» (or); при 

вводе второго правила, где отсутствует переменная «еда», для нее выбирается 

опция none. Итоговый набор правил выглядит следующим образом: 

1. If (сервис is плохой) or (еда is подгоревшая) then (чаевые is 

малые) (1) 



2. If (сервис is хороший) then (чаевые \а средние) (1) 

3. If (сервис is отличный) или (еда is превосходная) then (чае- 

вые is щедрые) (1) 

Такая (подробная, verbose) запись представляется достаточно понятной; 

единица в скобках после каждого правила указывает его вес (Weight), т.е. 

значимость правила. Данный вес можно менять, используя соответствующее поле 

в левой нижней части окна редактора правил, Правила представимы и в других 

формах: символической (symbolic) н индексной (indexed), при этом переход от 

одной формы к другой происходит через опции пункта меню редактора правил 

Options/Format. Вот как выглядят рассмотренные правила в символической форме: 

1. (сервис==плохой)|(еда==подгоревшая)=> (чаевые=малые) (1) 

2. (сервис==хороший) => (чаевые=средние) (1) 

3. (сервис==отличный)|(еда==превосходная)=>(чаевые=щедрые) (1) 

Наконец, самый сжатый формат представления правил — индексный — 

является тем форматом, который в действительности используется программой. В 

этом формате приведенные правила выглядят так: 

1 1, 1 (1): 2 

2 0, 2 (1): 2 

3 2, 3 (1): 2 

Здесь первая колонка относится к первой входной переменной 

(соответственно, первое, второе или третье возможное значение), вторая — ко 

второй, третьл (после за пятой) — к выходной переменной, цифра в скобках 

показывает вес правила и последняя цифра (после двоеточия) — на тип «связки»   

(1 для «И», 2 для «Или»). 

На этом конструирование экспертной системы закончено. Сохраним ее на 

диске под выбранном именем (tip). 

Самое время теперь проверить систему в действии. Откроем 

(через пункт меню View/View rules...) окно просмотра правил 

п установим значения переменных: сервнс=0 (т.е. никуда не 

годный), еда=10 (т.е. превосходная). Увидим ответ: чаевые=15 

(т.е. средние). Ну что ж, с системой не поспоришь, надо платить. Можно 

проверить и другие варианты. В частности выяснится, что нашей системой 

обслуживание ценится больше, чем качество еды. 

Подтверждением отмеченной зависимости выходной переменной от 

входных может служить вид поверхности отклика, который представляется при 

выборе пункта меню View/View surface; обратите внимание, что с помощью 

мышки график можно поворачивать со все стороны. 



В открывшемся окне, меняя имена переменных в полях ввода (X(input) и 

Y(input)), можно задать и просмотр одномерных зависимостей, например, 

«чаевых» от «еды».  

 

Экспорт и импорт результата.  

Когда вы сохраняете созданную вами нечеткую систему, используя пункты 

меню File/Save to disk или File/Save to disk as..., на диске создается текстовый 

(ASCII) файл достаточно простого формата с расширением .fis, который можно 

просматривать, при необходимости — редактировать вне системы MATLAB, а 

также использовать повторно при 

последующих сеансах работы с системой.   

 

Создание пользовательских функций принадлежности. 

Если по каким-либо причинам вас не устраивает ни одна из встроенных 

функций принадлежности, вы можете создать и использовать собственную 

подходящую функцию. Такая функция должна быть создана как М-файл со 

значениями от 0 до 1 и с числом аргументов не более 16. Приведем этапы 

создания данной функции под некоторым именем custmf. 

1.Создается соответствующий М-файл с именем custmf.m. 

2. Выбирается пункт Edit/Add custom MF (Редактирование/ Добавить 

пользовательскую функцию принадлежности) в меню редактора функций 

принадлежности. 

3. В поле M-File function namе появляющегося диалогового окна Add 

customized membership function вводится имя созданного М-файла (custmf). 

4. В поле Parameter List данного окна вводятся необходимые числовые 

параметры. 

5. Наконец, в поле MF name (Имя функции принадлежности) вводится 

какое-либо (уникальное) имя задаваемой функции (например, custmf). 

6. Указанный ввод подтверждается нажатием кнопки ОК. 

 

В рамках пакета пользователь может выполнять необходимые действия по 

разработке и использованию нечетких моделей в одном из следующих режимов: 

� в интерактивном режиме с помощью графических средств 

редактирования и визуализации всех компонентов систем нечеткого вывода; 

� в режиме команд с помощью ввода имен соответствующих функций с 

необходимыми аргументами непосредственно в окно команд системы MATLAB 



Для разработки и дальнейшего применения систем нечеткого вывода в 

интерактивном режиме могут быть использованы следующие графические 

средства, входящие в состав пакета Fuzzy Logic Toolbox. 

� Редактор систем нечеткого вывода FIS (FIS Editor) или сокращенно 

редактор FIS. 

� Редактор функций принадлежности системы нечеткого вывода 

(Membership Function Editor) или сокращенно редактор функций принадлежности. 

� Редактор правил системы нечеткого вывода (Rule Editor) или 

сокращенно редактор правил. 

� Программа просмотра правил системы нечеткого вывода (Rule 

Viewer). 

� Программа   просмотра   поверхности   системы   нечеткого   вывода   

(Surface Viewer). 

Кроме этих графических средств, в состав пакета Fuzzy Logic Toolbox также 

входят следующие специальные программы. 

� Редактор систем нечеткого вывода FIS 

� Редактор систем нечеткого вывода FIS (или просто редактор FIS) 

является основным средством, которое используется для создания или 

редактирования систем нечеткого вывода в графическом режиме. Редактор FIS 

может быть открыт с помощью ввода функции fuzzy или fuzzy ('a') в окне команд. 

Эта функция предоставляет пользователю возможность задавать и редактировать 

на высоком уровне свойства системы нечеткого вывода, такие как число входных 

и выходных переменных, тип системы нечеткого вывода, используемый метод 

дефазификации и т. д.  

Если функция fuzzy вызывается без аргументов, то редактор FIS вызывается 

для вновь создаваемой системы нечеткого вывода с именем Untitled по умолчанию 

(рис. 1). 



 

Рис.1 Графический интерфейс редактора FIS, вызываемый функцией fuzzy 

 

При этом по умолчанию также задается целый ряд параметров, таких как 

тип системы нечеткого вывода (Мамдани), нечеткие логические операции, методы 

импликации, агрегирования и дефазификации и некоторые другие. Пользователь 

может согласиться с этими значениями или изменить их. 

Если функция fuzzy вызывается с аргументом в форме fuzzy ('а'), где а – имя 

внешнего файла с расширением fis с уже разработанной системой нечеткого 

вывода, то редактор вызывается с уже загруженной системой FIS с именем а. 

Редактор FIS имеет главное меню, которое позволяет пользователю 

вызывать другие графические средства работы с системой нечеткого вывода FIS, 

загружать и сохранять структуру FIS во внешних файлах и т.д.  

Пункт меню File (Файл) редактора FIS содержит следующие операции: 

New FIS... – позволяет выбрать тип задаваемой новой системы нечеткого 

вывода: Mamdani – типа Мамдани или Sugeno – типа Сугено. При этом 

задаваемая система нечеткого вывода не имеет ни входных, ни выходных 

переменных, а ее имя задается по умолчанию как Untitled; 

Import – позволяет загрузить в редактор FIS существующую систему не 

четкого вывода одним из следующих способов: From Workspace... – из 



рабочего пространства программы MATLAB или From Disk... – из                                    

внешнего файла; 

Export – позволяет сохранить редактируемую систему нечеткого вывода 

одним из следующих способов: То Workspace... – в рабочем пространстве 

программы MATLAB или То Disk... – во внешнем файле; 

Print – позволяет распечатать на принтере редактируемую систему нечетко 

го вывода; 

Close – закрывает редактор FIS. 

Пункт меню Edit (Редактирование) содержит следующие операции: 

Undo – отменяет выполнение последнего действия; 

Add Variable... – позволяет добавить в редактируемую систему нечеткого 

вывода переменную одного из следующих типов: Input – входную переменную 

или Output – выходную переменную; 

Remove Selected Variable – удаляет выбранную переменную из                                      

редактируемой системы нечеткого вывода; 

Membership Functions... – вызывает редактор функций принадлежности; 

Rules – вызывает редактор правил нечеткого вывода. 

Пункт меню View (Вид) содержит следующие операции: 

Rules – вызывает программу просмотра правил нечеткого вывода; 

Surface – вызывает программу просмотра поверхности нечеткого вывода. 

В левой нижней части рабочего интерфейса редактора FIS имеется 5 

всплывающих меню: 

And method (Метод логической конъюнкции) – позволяет задать один из 

следующих методов для выполнения логической конъюнкции в условиях нечетких 

правил: 

min – метод минимального значения; 

prod – метод алгебраического произведения; 

Custom – метод, определенный пользователем. 

Or method (Метод логической дизъюнкции) – позволяет задать один из                                       

следующих методов для выполнения логической дизъюнкции в условиях                

нечетких правил: 

max – метод максимального значения; 

probor – метод алгебраической суммы; 

Custom – метод, определенный пользователем. 

Implication method (Метод вывода заключения) – позволяет задать один из 

следующих методов для выполнения (активизации) логического заключения в 

каждом из нечетких правил (не используется для систем типа Сугено): 



min – метод минимального значения; 

prod – метод алгебраического произведения; 

Custom – метод, определенный пользователем.  

Aggregation method (Метод агрегирования) – позволяет задать один из                                      

следующих методов для агрегирования значений функции принадлежности                                    

каждой из выходных переменных в заключениях нечетких правил: 

max – метод максимального значения; 

sum – метод граничной суммы; 

probor – метод алгебраической суммы  

Custom – метод, определенный пользователем.  

Defuzzification method (Метод дефазификации) – позволяет задать один из 

следующих методов для выполнения дефазификации выходных переменных 

в системе нечеткого вывода типа Мамдани: 

centroid – метод центра тяжести для дискретного множества значений 

функции принадлежности 

bisector – метод центра площади; 

mom (middle of maximum) – метод среднего максимума, определяемый как 

среднее арифметическое левого и правого модальных значений; 

som (smallest of maximum) – метод наименьшего (левого) модального зна-

чения; 

lom (largest of maximum) – метод наибольшего (правого) модального зна-

чения; 

Custom – метод, определенный самим пользователем. 

Для систем нечеткого вывода типа Сугено можно выбрать один из следую-

щих методов дефазификации: 

wtaver (weighted average) – метод взвешенного среднего; 

wtsum (weighted sum) – метод взвешенной суммы. 

 

Редактор функций принадлежности 

Редактор функций принадлежности предназначен для задания и 

редактирования функций принадлежности отдельных термов системы нечеткого 

вывода в графическом режиме. Редактор функций принадлежности может быть 

открыт с помощью ввода функции mfedit, а также mfedit ('а') или mfedit (а), в окне 

команд либо с помощью главного меню редактора FIS (командой меню 

Edit>Membership Functions... или нажатием клавиш <Ctrl>+<2>). 

Функция в формате mfedit ('а') вызывает редактор функций принадлежности, 

который позволяет пользователю в графическом режиме анализировать и 



модифицировать все функции принадлежности некоторой структуры FIS, 

сохраненной во внешнем файле с именем a.fis. Функция в формате mfedit (а) 

работает с переменной рабочего пространства MATLAB, соответствующей 

структуре F1S с именем а. Для каждой функции принадлежности можно изменить 

ее имя, тип и параметры. Редактор предоставляет пользователю не только 

возможность выбрать любую из 11 встроенных функций принадлежности, но и 

задать собственную функцию принадлежности. 

Результат вызова редактора функций принадлежности с помощью функции 

mfedit  на рис. 2. 

 

Рис. 2 Редактор функций принадлежности 

 

Для отображения графиков функций принадлежности следует выбрать 

необходимую переменную в левой части графического интерфейса редактора под 

заголовком FIS Variables (Переменные FIS). Чтобы выбрать нужную функцию 

принадлежности, следует щелкнуть на ней или ее метке в основном окне с 

графиками функций принадлежности. 

Редактор функций принадлежности имеет главное меню программы, 

которое позволяет пользователю вызывать другие графические средства работы с 



системой нечеткого вывода FIS, загружать и сохранять структуру FIS во внешних 

файлах и т. д. 

Пункт меню File (Файл) редактора функций принадлежности содержит 

такие же операции, что и соответствующий пункт меню редактора FIS. 

Пункт меню Edit (Редактирование) содержит следующие операции: 

Undo – отменяет выполнение последнего действия; 

Add MF... – позволяет добавить встроенную функцию принадлежности 

термов для выделенной переменной; 

Add Custom MF... – позволяет добавить  функцию принадлежности для 

отдельной переменной; 

Remove Current MF – позволяет удалить отдельную функцию принадлеж-

ности; 

Remove All MFs – позволяет удалить все функции принадлежности для 

отдельной переменной; 

FIS Properties... – вызывает редактор FIS; 

Rules... – вызывает редактор правил нечеткого вывода. 

Пункт меню View (Вид) содержит следующие операции; 

Rules – вызывает программу просмотра правил нечеткого вывода; 

Surface – вызывает программу просмотра поверхности нечеткого вывода. 

 

Редактор правил вывода 

Редактор правил системы нечеткого вывода, как следует из его названия, 

предназначен для задания и редактирования отдельных правил системы нечеткого 

вывода в графическом режиме. Редактор правил может быть открыт с помощью 

ввода функции ruleedit (‘а’) или ruleedit (а) в окне команд либо с помощью 

главного меню редактора FIS (командой меню Edit>Rules... или нажатием клавиш 

<Ctrl>+<3>). 

Эта функция, записанная в формате ruleedit (‘а’), вызывает редактор правил, 

который позволяет пользователю в графическом режиме анализировать и 

модифицировать правила продукций системы нечеткого вывода FIS, сохраненной 

во внешнем файле с именем a.fis. Эта функция позволяет также выполнять 

грамматический анализ правил, которые используются в некоторой системе 

нечеткого вывода FIS. 

Чтобы использовать данный редактор для создания правил, необходимо 

предварительно определить все входные и выходные переменные, для чего можно 

воспользоваться редактором системы нечеткого вывода FIS и редактором функций 



принадлежности. При этом задать правила можно с помощью выбора соот-

ветствующих значений термов входных и выходных переменных. 

Пункт меню File (Файл) редактора правил содержит такие же операции, что 

и соответствующий пункт меню редактора FIS. 

Пункт меню Edit (Редактирование) содержит следующие операции: 

Undo – отменяет выполнение последнего действия; 

FIS Properties... – вызывает редактор FIS; 

Membership Functions... – вызывает редактор функций принадлежности. 

Пункт меню View (Вид) содержит следующие операции: 

Rules – вызывает программу просмотра правил; 

Surface – вызывает программу просмотра поверхности вывода. 

Пункт меню Options (Сервис) содержит следующие операции: 

Language – позволяет выбрать язык для записи правил в форме текста: 

English (английский), Deutsch (немецкий) или Francais (французский); 

Format – формат записи правил системы нечеткого вывода: Verbose (в форме 

текста), Symbolic (в символической форме) или Indexed (в цифровой форме). 

Поля ввода в средней части графического интерфейса редактора правил 

позволяют задать новое правило в системе нечеткого вывода. Для этого 

необходимо выделить имя терма соответствующей переменной, которая должна 

быть предварительно определена с помощью редактора функций принадлежности. 

Если некоторый терм не входит в правило, то для него следует выбрать значение 

"none". Если в условии правила используется логическое отрицание некоторого 

терма, то для этого терма следует отметить соответствующий флажок с меткой 

"not". 

Редактор правил позволяет также задать логические связки для подусловий 

правила (переключатель Connection) и вес правила (поле ввода Weight). Кнопки в 

нижней части графического интерфейса редактора правил, как следует из их на-

званий, служат для удаления выделенного в окне правила (Delete rule), добавления 

созданного правила в систему (Add rule) и внесения изменений в выделенное в 

окне правило (Change rule). В правом нижнем углу находятся кнопки вызова 

встроенной справочной системы MATLAB (Help) и кнопка закрытия редактора 

правил (Close). 

 

Средство просмотра поверхности вывода 

Программа просмотра поверхности системы нечеткого вывода позволяет 

просматривать поверхность системы нечеткого вывода и визуализировать графики 

зависимости выходных переменных от отдельных входных переменных. Графиче-



ский интерфейс программы просмотра правил может быть открыт с помощью 

ввода функции surfview('a') или surfview(a) в окне команд либо с помощью 

главного меню редактора FIS, редактора функций принадлежности или редактора 

правил (командой меню View>Surface или нажатием клавиш <Ctrl>+<6>). 

Функция, записанная в формате surf view ('а'), вызывает программу просмот-

ра поверхности, которая изображает поверхность нечеткого вывода для структуры 

FIS, сохраненной во внешнем файле с именем a.fis, для любой одной или двух из 

ее входных переменных. Функция в формате surfview(a) вызывает программу 

просмотра поверхности вывода для переменной рабочего пространства MATLAB, 

соответствующей структуре FIS с именем а. 

Программа просмотра поверхности вывода имеет главное меню, которое 

позволяет пользователю вызывать другие графические средства работы с 

системой нечеткого вывода FIS, загружать и сохранять структуру FIS во внешних 

файлах и т. д. 

Пункт меню File (Файл) редактора правил содержит такие же операции, что 

и соответствующий пункт меню редактора FIS. 

Пункт меню Edit (Редактирование) содержит следующие операции: 

Undo — отменяет выполнение последнего действия; 

FIS Properties... — вызывает редактор FIS; 

Membership Functions... — вызывает редактор функций принадлежности; 

Rules... — вызывает программу редактирования правил. 

Пункт меню View (Вид) содержит следующие операции: 

Rules — вызывает программу просмотра правил. 

 Пункт меню Options (Сервис) содержит следующие операции: 

Plot — позволяет выбрать один из 8 стилей изображения графика поверх-

ности вывода; 

 Color Map— позволяет выбрать одну из 4 цветовых схем изображения 

 графика поверхности вывода; 

 Always evaluate — пометка галочкой этого пункта вложенного меню при 

водит к автоматическому формированию новой поверхности вывода всякий раз, 

когда вносятся изменения в систему нечеткого вывода, влияющие 

на форму графика поверхности вывода (такие как изменение количества 

точек сетки графика). Это значение принято по умолчанию. Чтобы его 

отменить, необходимо снять галочку у этого пункта вложенного меню, 

щелкнув на этой позиции меню. 

Программа просмотра поверхности вывода не позволяет вносить изменения 

в систему нечеткого вывода и соответствующую ей структуру FIS. Используя 


